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· A GUI status is made up of a menu bar, a standard toolbar, an application toolbar, and of function key settings. Each screen can have one or more GUI statuses. For example, an editor program might have two statuses: one for display mode and one for change mode. 

· The elements of a GUI status allow users to choose functions using the mouse.

· Menus are control elements that allow the user to choose which functions will be processed by an application program. Menus can also contain submenus. The System and Help menus are present on every screen in the R/3 System. They always have identical functions and cannot be changed or hidden. 

· The application toolbar contains icons for frequently used functions. The standard toolbar, which is the same on every screen in the R/3 System, contains a set of icons, each of which has a fixed assignment to a corresponding function key. If a function in the standard toolbar is not available on the current screen, the icon is grayed out.  

· The application toolbar allows the user to choose frequently used functions by clicking the corresponding button.  

· You use the function key settings to assign functions such as Find, Replace, or Cut to the function keys.

· All of a program's GUI titles and statuses taken together make up its user interface. Whenever you add a new title or status, you must regenerate the user interface.
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· There are three ways to create a title: from the object list in the Object Navigator, from the Menu Painter, or by forward navigation from the ABAP Editor.

· The name of a title can be up to 20 characters long.

· You should set an appropriate title for each screen in your application.  

· You can use variables in titles that are set dynamically at runtime by including the ampersand character (&) as a placeholder. At runtime, the ampersand is replaced by a value that you specify.  You can use up to nine variables by placing digits after the ampersand. 
To set a title that contains variables, use the statement: 

 SET TITLEBAR <title_name> WITH <&1> ... <&9>. 

· A title bar remains in place until you set another one.  At runtime, the system variable sy-title contains the current title. Title bars are also known as GUI titles.
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· From a technical point of view, a status is a reference to a menu bar, to certain key assignments, and to an application toolbar.

· A single component (such as a menu bar) can be used by more than one GUI status.

· GUI statuses are ABAP program objects that can be displayed on screens and lists.

· You should set a status for every screen in your application. 
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· A menu bar is made up of individual menus.

· Key assignments and application toolbars are subobjects of the function key settings. 

· You can create a set of application toolbars for a single key setting by choosing the menu path GUI-1. Functions must be assigned to a function key before you can assign them to a pushbutton. Each status contains a single application toolbar. 

· All program menus and key assignments refer to the set of all interface functions (function list). These functions can be reached using F4 help. The application toolbar refers to the functions indirectly via the standard settings. 

· A function within a status can be either active or inactive.  
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· Functions are identified by their function codes.

· The attribute function type determines the intended purpose of a function. Use the function types ' ' (space), E, and P  for pushbuttons, which you place on a screen using the Screen Painter, and for tab titles. Function types S and H are reserved for internal use by the SAP System. Function type T indicates a transaction code. When a function of this type is triggered, the system leaves the calling program and calls the new program. 

· Functions can be created with static texts or dynamic texts.

· If a function has a static text, you can assign an icon to it (Icon name attribute). If the function is already assigned to a pushbutton, an icon is displayed instead of the static text. The static text is used when you assign the function to a menu entry. The function text belonging to the function is used as quick info text.  The contents of the Infotext attribute appear in the status bar of the screen when the user chooses the function. If you want to display text as well as the icon, enter the text in the Icon text attribute.

· You can use the Fastpath attribute to specify the letters that allow you to choose a function from the menu bar without using the mouse.

· For further information, refer to the online documentation path in appendix reference GUI-2.
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· Functions can be assigned to individual function keys or buttons. 

· Function key settings consist of a key assignment and an application toolbar pushbutton.

· The type of function key settings (screen and dialog box) determines the exclusive technical purpose of the function key setting. In addition, you can set options for the implementation of context menus and input help on lists. For more information on using context menus in lists, see the Context Menus unit later in this course.   

· Key assignments consist of reserved functions keys, recommended functions keys, and freely assigned function keys. Reserved functions keys are function keys whose assigned values cannot be changed in the SAP system. You may activate and deactivate their functions, but you cannot change the icons and texts assigned to them. Reserved function keys appear in the standard toolbar on screens and lists. Recommended function keys contain proposals, which comply with the SAP System's ergonomic standards. 

· Functions that have been assigned to function keys can also be assigned to buttons in the application toolbar.

· An application toolbar can contain up to 35 buttons. You can insert vertical separators in the button bar to group buttons visually. You can control the display of inactive functions in the application toolbar by choosing  Goto ( Attributes ( Pushbutton settings.
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· A menu can contain up to 15 entries. 

· Possible entries are functions, separators, and menus (cascading menus).

· Menus can be up to three levels deep. The third level may contain only functions and separators.

· Menus can be created with static or dynamic text. If you want to use dynamic text, you must assign a field to the menu. The contents of this field will be displayed as the menu text.

· The menu type Include menu allows you to reference menus in other programs. When you do this, you must specify the name of the program and status from which you want to include the menu next to the Short documentation field. 

· Include menus can be accessed only using the menu bar.

· A menu bar can contain up to eight different menus. Up to six of these can be freely assigned. The system automatically adds both the System menu and the Help menu to every menu bar. 
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· The status type indicates the technical attributes of the status. You can choose between a dialog status (status for fullscreen) or a dialog box status (for use with modal dialog boxes). Context menus are special collections of functions that can be displayed with a right-click. We deal with them separately in the Context Menus unit.  

· You can create a status by creating links to existing components or by creating a new blank status. You can also combine the two techniques. If you want to create an entirely new status, you must then create your own menu bars, menu functions, and other elements. Changes to a status only affect that status. 

· When you use the reference technique, you create menu bars, application toolbars, and function key assignments as independent elements. You then create your own status and refer to the menu bar, application toolbar, and any function key assignment you want. The Menu Painter stores and maintains these references so that any changes in the menu bar, application toolbar, or function key assignments automatically take effect in all statuses referring to them.

· The linking technique is particularly effective for ensuring consistency in very large applications that use several statuses. The links ensure that the user can access functions in the same way whatever status is set. 
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· In a key setting, you assign individual functions to function keys and pushbuttons. Function key settings consist of a key assignment and a set of application toolbars. 

· Key settings can have various types (screen, dialog box, list, and list in dialog box).

· You can attach functions to reserved function keys, recommended function keys, and freely assigned function keys. Make sure that they conform to the SAP System's ergonomic standards, which can be found in the Environment menu in the Menu Painter.

· Reserved function keys appear in the standard toolbar on screens and lists. 

· If a function is important, and you have already assigned it to a function key, you can also assign it to a pushbutton in the application toolbar. The application toolbar may contain up to 35 buttons.
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· When you assign a function to the standard toolbar it is also automatically assigned to a reserved function key.

· To find out the function keys to which these functions are assigned in the current status, select the Information in the Menu Painter.

· For more information about how key combinations such as Ctrl-P are converted into internal function key numbers (for example, for batch input), follow menu path GUI-3 in the Menu Painter. 
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· You can use a function in the application toolbar only if you have already assigned it to a function key. 

· Use the F4 help to select functions.

· If you assign an icon to a function with a static text (Icon name attribute), the system displays the icon instead of the static text in the application toolbar. The function text belonging to the function is used as quick info text. The contents of the Infotext attribute appear in the status bar of the screen when the user chooses the function. If you want to display additional text with an icon, it should be entered in the Icon text attribute.

· To insert a separator in the application toolbar, use the Insert menu in the Menu Painter.  
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· A menu entry can be a function, a separator, or another menu (cascading menu).

· To add a function to a menu, enter its function code in the left-hand column. If the function already exists in the function list and has a text assigned to it, this is entered automatically in the text field. If not, double-click the right-hand field to enter a text.

· To insert a separator, use the Insert menu, fill the function text field with minus signs at the appropriate position or use the Context menu.  

· To create a submenu, simply enter its name in the right field of the menu entry. 
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· To ensure consistency, you should reuse existing menu bars, application toolbars, and key settings wherever possible. The Menu Painter administers the links you establish between these objects so that any changes apply to all other statuses that use them. You can also use a set of standard menu entries as a template and modify them. 

· When you assign functions to the reserved function keys in the standard toolbar, you should adhere to the SAP  System standards. This makes your program easier for users to understand and for you to maintain. 
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· Using the Menu Painter in a status, you can include key settings, application toolbars, or menu bars that you have already defined elsewhere. If you do this, work from the bottom upward. If there is more than one application toolbar defined for your key setting, you can choose the appropriate one. 

· Initially, all functions are inactive. Activate only the functions that are relevant in the current status. 

· When you create a new function, you can decide whether all statuses that refer to the same object should also be changed. The new functions are initially inactive.
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· When the user triggers a function with type ' ' using a button, menu entry, or function key, the system places the relevant function code in the OK_CODE field of the screen.   

· To allow you to process this field in the PAI event, you must assign a name to the field, which you then enter in the element list in the Screen Painter. You must then create a field in your ABAP program with the same name. During the automatic field transport at the beginning of the PAI event, the function code is passed from the screen to the corresponding field in the program.  

· To avoid the function code leading to unexpected processing steps on the next screen (enter does not usually change the command field), you should initialize the identically named ABAP field. The initial value is then automatically transported to the corresponding command field at PBO.   
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· You can initialize the command field at PAI or at PBO. 

· The simplest method is to insert a module at the end of PBO in which the identically named ABAP field is initialized. The automatic data transport initializes the command field. 

· Another method is to copy the OK_CODE field explicitly to a field of similar type, and then to initialize it.

· Note: You cannot combine the two methods. If you do this, errors may occur in the processing of the screens that initialize the OK_CODE field at PAI.       
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	Unit : The Program Interface

Topic: Creating a GUI status and using it with a screen
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	At the conclusion of these exercises, you will be able to:

· Create online statuses and use them in your programs.
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	Use Menu Painter to create GUI Status and GUI Title. 


1-1
Create a GUI Title and a GUI Status for a screen. 

Extend your program SAPMZ##BC410_SOLUTION from the previous exercise (or copy the model solution SAPMBC410ADIAS_DYNPRO). You can use the model solution SAPMBC410ADIAS_GUI for orientation.


1-2
In the PBO event of screen 100, call a module status_0100. Use forward navigation to create the module in a new include. Accept the system’s proposal for the name (MZ##BC410_SOLUTIONO01).  In this module, set the GUI status STATUS_100 and GUI title TITLE_100 (Flight data). You can create the status and title by forward navigation. 

Choose Online status for the Status type and Maintenance screen for Short text. Activate the standard function BACK (F3) with the function type ‘ ’ (space).

1-3
Assign the name OK_CODE to the function code field on your screen, and create a corresponding variable in the top include of your program.  

1-4
Implement the command field processing. Use forward navigation to create the PAI modules in a new include. Accept the system’s proposal for the name (MZ##BC410_SOLUTIONI01). Ensure that the user returns from screen 100 to the point from which it was called if he or she chooses BACK (F3) only.

1-5
To avoid unnecessary navigation, initialize the command field in a module at the PBO event of the screen.

The Program Interface Solutions
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	Unit 3: The Program Interface

Topic: Creating a GUI status and using it with a screen


Solution SAPMBC410ADIAS_GUI

Main program

INCLUDE MBC410ADIAS_GUITOP.

INCLUDE MBC410ADIAS_GUII01.

INCLUDE MBC410ADIAS_GUIO01.

Flow logic for screen 100

PROCESS BEFORE OUTPUT.

  MODULE status_0100.

  MODULE clear_ok_code.
*

PROCESS AFTER INPUT.

  MODULE user_command_0100.

Top include

PROGRAM  sapmbc410adias_gui.

DATA ok_code TYPE sy-ucomm.

PAI module include

MODULE user_command_0100 INPUT.

  CASE ok_code.

    WHEN 'BACK'.

      LEAVE TO SCREEN 0.

  ENDCASE.

ENDMODULE.                 " user_command_0100  INPUT

PBO module include

MODULE status_0100 OUTPUT.

  SET PF-STATUS 'STATUS_100'.

  SET TITLEBAR 'TITLE_100'.

ENDMODULE.                 " status_0100  OUTPUT

MODULE clear_ok_code OUTPUT.

  CLEAR ok_code.

ENDMODULE.                 " clear_ok_code  OUTPUT
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